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7 Brokers and bridges

7.1 Introduction

A person with many social relations has better chances of getting help or

information. Therefore, social relations are called social capital, an asset which

pays off. Network analysts, however, discovered that the kind of relation is

important in addition to the sheer number of relations. Their general argument is

that ‘strong’ relations with people who are themselves related yield less useful

information than ‘weak’ relations with people who do not know one another.

Having a lot of relations within a group exposes a person to the same information

over and over again, whereas relations outside one’s group yield more diverse

information which is worth passing on or retaining to make a profit.

As a consequence, we have to pay attention to the relations between a

person’s contacts. A person who is connected to people who are themselves not

directly connected has opportunities to mediate between them and profit from his

or her mediation. The relations of this person bridge the structural holes between

others.  It is hypothesized that people and organizations who bridge structural

holes between others have more control and perform better.

In this chapter, we will first discuss bridges at the level of the entire network

(Section 7.3). Which relations (bridges) and which vertices (cut-vertices) are

indispensable for the network to remain connected? If a network contains such

relations and vertices, it contains ‘bottlenecks’ and the flow of information

through the network is vulnerable. In the remaining sections, we will focus on

brokerage at the level of individuals. Who is in the best position to profit from his

or her social relations (Section 7.4) and how is this affected by group membership

(Section 7.5)?

7.2 Example

The example of this chapter will show the importance of informal communication

structures within a firm. In the wood-processing facility which already appeared

in Chapter 6 a new management team proposed changes to the workers’

compensation package, which the workers did not accept. They started a strike,

which lead to a negotiation stalemate. Then, management asked an outsider to

analyze the communication structure among the employees because it felt that

information about the proposed changes was not effectively communicated to all

employees by the union negotiators.

The outside consultant asked all employees to indicate the frequency in which

they discussed the strike with each of their colleagues on a 5-point scale, ranging

from ‘almost never’ (less then once per week) to ‘very often’ (several times per
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day). The consultant used three as a cut-off value. If at least one of two persons

indicated that they discussed work with a frequency of three or more, a line

between them was added to the informal communication network (Strike.net).

The network displays fairly stringent demarcations between groups defined

on age and language (Figure 1). The Spanish-speaking young employees, who are

of age 30 or younger, (class one in the partition Strike_groups.clu, yellow

vertices in Figure 1) are almost disconnected from the English-speaking young

employees (class 2, green vertices), who communicate with no more than two of

the older English-speaking employees (38 years or more, class 3: red vertices).

These divisions mirror the homophily principle discussed in Chapter 3: people

tend to relate to similar people.

All ties between groups have special backgrounds. Among the Hispanics,

Alejandro is most proficient in English and Bob speaks some Spanish, which

explains their tie. Bob owes Norm for getting his job and probably because of

this, they developed a friendship relation. Finally, Ozzie is the father of Karl.

Figure 1 - Communication network of striking employees.

Sam and Wendle are the union negotiators (the boxes in Figure 1). They were

responsible for explaining the new program proposed by the managers. When the

informal communication structure among employees was reported to the

management, they approached two of the other employees directly (guess who?)

to explain the reforms to them personally. Then, they gave them some time to

discuss the plans with their colleagues. Within two days, the young and old

employees were willing to strike a deal with the management and they persuaded

the union representatives to reopen negotiations. Soon, the labor dispute was

reconciled and the strike ended.

7.3 Bridges and bi-components

The example shows the importance of social ties to the diffusion of information.

Information is the key to the exploitation of social relations as social capital.

Social ties offer access to information, which can be used to reduce uncertainty
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and risk, and to create trust, for instance, when information is confirmed from

several sources. People on crucial positions in the information network may also

spread or retain information strategically because they have control over the

diffusion of information.

In a social system, for instance, an organization, the overall structure of

informal ties is relevant to the diffusion of information. Can information reach all

members of the organization or is it more likely to circulate in one segment of the

network? Are there any bottlenecks which are vital to the flow of information,

which may prohibit the spread of information because of information overload or

because people pursue their private, strategic goals?

In Figure 1, the tie between Alejandro and Bob is clearly a bottleneck because

it is the only channel for information exchange between the Hispanic employees

and all other employees. Removing this single line will cut off the Hispanics from

information circulating among the other employees. Formally, this line is a

bridge in the network because its removal creates a new component, which is

isolated from other components. The strike network consists of one component

(recall that a component is a maximal connected subnetwork, see Chapter 3), so

information may travel to each employee via social ties. When you remove the

line between Alejandro and Bob, you disconnect the Hispanic workers from the

communication network, so they become a component on their own.

A bridge is a line whose removal increases the number of components in the

network.

Note that there is one more bridge in the information network of striking

employees: the tie between Frank and Gill. If you remove this tie, Frank becomes

an isolate. Since an isolate is a component, the network consists of two

components after removing Frank’s tie with Gill.

The removal of a line may annul the connectedness of a network or

component but the deletion of a vertex may have the same effect, because you

remove the lines which are incident with the deleted vertex. After all, you cannot

have a line with a single endpoint! When Bob refuses to discuss the strike

anymore, he is lost to the communication network and all of his ties disappear,

including the bridge to Alejandro. Therefore, Bob is a cut-vertex: its deletion

disconnects the network or it disconnects a component of the network. Just like a

bridge, a cut-vertex is crucial to the flow of information in a network. It is a

‘bottleneck’ in the network which controls the flow from one part to another part

of the network. Norm, for example, is indispensable for exchanging information

between the older and younger employees.

Deleting a vertex from a network means that the vertex and all lines incident

with this vertex are removed from the network.

A cut-vertex is a vertex whose deletion increases the number of components in

the network.
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Figure 2 - Bi-components and cut-vertices in the strike network.

In Figure 2, all cut-vertices are brown. Note that vertices incident with a bridge

may or may not be cut-vertices. Alejandro and Bob are cut-vertices, but Frank is

not, because removal of Frank and his bridge to Gill does not increase the number

of components.

Now that we have defined cut-vertices, it is easy to define sections of a

network which are relatively invulnerable to the withdrawal or manipulation of a

single vertex, namely a bi-component. A bi-component is simply a component - a

maximal connected subnetwork - without a cut-vertex. In a bi-component, no

person can control the information flow between two other persons completely

because there is always an alternative path which information may follow. In a bi-

component, each person receives information from at least two sources (in an

undirected network), so s/he may check the information.

A bi-component is a component which does not contain a cut-vertex.

Figure 2 shows the cut-vertices, which are brown, in the strike network. A cut-

vertex always belongs to two or more bi-components. Probably, this sounds weird

to you: didn’t we define a bi-component as a component without cut-vertices,

then how can a cut-vertex belong to two or more bi-components? The answer is

that a bi-component does not contain cut-vertices if you look at the bi-component

only and ignore the rest of the network. Concentrate on the Hispanic employees,

for instance: if you remove Alejandro, the other three Hispanics remain

connected into one component, so the removal of Alejandro does not increase the

number of components among the Hispanic employees.

Looking at the entire network, however, Alejandro is a cut-vertex because he

belongs to the Hispanic (red) bi-component and to a small bi-component with

Bob: the two bi-components overlap. A network usually consists of overlapping

bi-components.

Knowing this, you may now identify the six bi-components in the strike

network. Five bi-components are identified by the color of their vertices: yellow,

green, pink, red, and white. Keep in mind that the (brown) cut-vertices which are
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incident to the vertices of a bi-component also belong to that bi-component. The

bridge between Bob and Alejandro is the sixth bi-component, which consists only

of cut-vertices, so it cannot be identified by vertex color.

The two union representatives among the employees, Wendle and Sam, are

part of one small bi-component which is connected to the bi-component of older

employees by Sam. So we may say that Sam controls the information exchange

between the union representatives and all other employees except Xavier. If Sam

does not want to strike a deal with the management of the firm, he can manipulate

the information to and from the other employees.

In numerous applications, it has been shown that people with strong ties are

cliques or tend to develop into cliques, for example, family ties are usually strong

in the sense that they are intense, and family relations display cliques: several or

all members of a family maintain strong relations among themselves. As a

consequence, family ties are not very useful in finding a new job because they

relate you to people with whom you are already related. Usually, they do not

supply information about new jobs of which you have not heard already. In

contrast, superficial and irregular contacts such as former colleagues or

acquaintances are better sources of information on new job opportunities. These

weak ties are more likely to be bridges to distant information networks, hence the

concept of “the strength of weak ties”, meaning that weak ties are often more

important for the dispersion of information than strong ties. The strength of a tie

may be taken as a proxy of its chances to be a network bridge.

This hypothesis could apply to the Spanish-speaking employees. Strong

ethnic ties develop into a clique and the only non-ethnic tie (between Alejandro

and Bob) is a bridge to the rest of the network. In this example, however, family

ties connect employees outside cliques: Gill is Frank’s cousin and Ozzie is Karl’s

father. We should note that the strength of weak ties depends on the situation: on

the shop floor, family ties, which are usually considered strong, may fulfill the

‘bridging’ role of weak ties because family ties are uncommon and they will not

develop into cliques within the firm (a firm is not the natural setting to raise a

family).

Remember, however, that we only consider the stronger communication ties

because irregular communication ties are disregarded (scores one and two on the

5-point scale) in this example. The strength of weak ties argument predicts that

strong ties will constitute cliques, which is clearly the case. Perhaps, the weaker

ties cross group boundaries more often. Note, that the strength of a tie may be

defined in several ways, e.g., frequency versus social intensity, which is

important to consider when you apply the strength of weak ties hypothesis.

Application

You may use the Bi-Components command in the Net>Components submenu for

finding bi-components and cut-vertices in a network. When asked, choose two as

the minimum size of a bi-component, unless your network contains many strings

of bridges which you do not want to count as separate bi-components. If you

Net>Components

>Bi-Components
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choose a larger minimum size, however, you must realize that you may not

identify all cut-vertices, which are also called articulation vertices, in the

network.

Pajek treats directed networks as if they were undirected, which means that it

identifies weak components without cut-vertices in directed networks. If you

symmetrize a directed network  before you execute the Bi-Components command,

you will obtain exactly the same results.

The output of the Bi-Components command consists of two partitions and a

hierarchy. The first partition, which is most useful, indicates the number of the bi-

component to which a vertex belongs. Vertices which do not belong to a bi-

component, e.g., isolates, are collected in class 0 and vertices which belong to

two or more bi-components - cut-vertices - are placed in class number 999998.

This partition is used in Figure 2.

The second partition indicates the number of bi-components to which a vertex

belongs: 0 for isolates, 1 for a vertex which belongs to exactly one bi-component,

2 for vertices which belong to two bi-components, etc. Finally, the hierarchy

shows the bi-components to which each vertex belongs. Note that we need a

hierarchy to store the bi-components because cut-vertices belong to two or more

bi-components.

In an undirected network without multiple lines, such as our example, bridges

are bi-components of size two (see Exercise 5). Therefore, you can easily find the

bridges in the hierarchy of bi-components: open the Edit screen with the

hierarchy of bi-components (see Figure 3) with the command

File>Hierarchy>Edit or with the Edit button on the left of the hierarchy drop list.

Figure 3 lists the six bi-components in the communication network among

striking employees. The size of each bi-component is reported between brackets,

so it is easy to find the two bridges in this example: bi-components four and six.

Double-click (or single right mouse click) them to see their vertices.

Figure 3 - Hierarchy of bi-components in the strike network.

7.4 Ego-networks and constraint

In the previous section, we analyzed the structure of the entire network, which is

a socio-centered approach. Now, we turn to the ego-network or ego-centered

File>Hierarchy>Edit
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approach: we focus on the position of one person in the network and his or her

opportunities to broker or mediate between other people.

Let us first have a look at a triad, which consists of a focal person (ego), an

alter, a third person, and the relations among them. The triad is the smallest

network which contains more than two persons and it highlights the complexities

of relations within a group. According to the sociologist Georg Simmel, a

complete triad (A in Figure 4) reduces the individuality of its members. When

three people are fully connected, they share norms and information, they create

trust by feedback, and conflicts between two members may be resolved or

moderated by the third person. In other words, complete connections between

three persons make them behave as a group rather than as a set of individuals.

Figure 4 - Three connected triads.

In an undirected triad which is connected but incomplete, for instance, networks

B and C in Figure 4, people are considered to be bound less by group norms. One

person is in an advantageous, powerful position, because s/he may broker

between the other two. The person in the middle (ego in B and alter in C, Figure

4) may profit from the competition between the other two, for example, ego

negotiates the price of a good or service to be delivered by either alter or the third

party in network B. Ego makes them compete, which would not be possible if

alter and third would agree about a price among themselves. This is known as the

tertius gaudens (“the third who benefits”) or the tertius strategy: induce and

exploit competition or rivalry between the other two, who are not directly related.

The absence of a relation between alter and the third party is known as a

structural hole, which may be exploited by ego.

A more malicious variant is known as divide et impera or the divide and rule

strategy, in which a person creates and exploits conflict between the other two in

order to control both of them, for example, ego tells alter unpleasant things about

the third party and the third party about alter, which results in hostility among

them. This would not be possible if they could directly check the information and

find out ego’s subversive strategy. Again, the structural hole allows ego to apply

this strategy.

In both strategies, an individual’s advantage or power is based on his or her

control over the spread of information, goods, or services, which stems from the

structure of his or her network. We want to stress that brokerage is related to the

absence of relations or ‘holes’ between neighbors, whereas we concentrated on

the presence of relations in our chapters about cohesive subgroups in Part II.

The opportunities which a structural hole offers in an incomplete triad have a

reverse side: they imply constraint in a complete triad. A complete triad is not just
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a triad without opportunities because it has no structural holes. No, the situation

is even worse from the perspective of brokerage, because you cannot withdraw

from any of these unrewarding relations without creating a structural hole around

yourself. In network A (Figure 4), ego is more or less obliged to maintain both

relations, because if ego stops the relation with one (e.g., with the third in A, so

triad C evolves), there is a structural hole around ego, which alter may take

advantage of.

The ego-network of a vertex contains this vertex, its neighbors and all lines

among the selected vertices.

Now, let us focus on the ego-network, which consists of ego, ego’s neighbors,

and the relations among them. Alejandro’s ego-network is displayed in Figure 5.

Note that this network fully contains the ego-networks of Carlos, Domingo, and

Eduardo. The ego-network of a person contains all triads which include this

person, so we can analyze it as a set of triads. For each triad, we can determine

whether it constrains ego or whether it contains a structural hole which ego may

exploit, for instance, Alejandro (ego) has an opportunity to broker between Bob

(alter) and Domingo (third) because Bob and Domingo are not directly connected.

For the same reason, Alejandro may broker between Bob and Carlos or Eduardo.

There are three triads in Alejandro’s ego-network which give him an opportunity

to broker for Bob.

Figure 5 - Alejandro's ego-network.

In a similar way, we can compute the constraint on Alejandro which is exercised

by his relation with Bob: the number of complete triads containing Alejandro,

Bob and another neighbor of Alejandro. Since no other neighbor of Alejandro is

directly connected to Bob, there is no constraint on Alejandro because of his

relation with Bob. A low constraint indicates many structural holes, which may

be exploited. In contrast, the constraint on Alejandro’s relations with Carlos,

Domingo, and Eduardo is very high because these relations are involved in three

complete triads. When Alejandro withdraws from any of these relations, they may

start brokering for him.

The higher the constraint, the fewer the opportunities to broker, and the more

dangerous it is to withdraw from a relation. This constraint is known as the

dyadic constraint associated with a relation from ego’s point of view. Note that

the constraint of a relation on ego may differ from the constraint experienced by

alter on the same relation. The relation between Alejandro and Carlos, for
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instance, is more constrained for Carlos than for Alejandro, because all Carlos’

triads are complete.

In our discussion of structural holes and constraint, something is still missing:

we ought to take into account the importance of a tie to a person. If a tie is very

cheap in terms of investment (money, network time, and energy), it is not really a

problem to be obliged to maintain it. If a tie is just one among many (low

exclusivity), ego does not depend on this tie much and it is no big deal if alter

threatens to break it. Besides, if the tie between alter and the third party is not

important to them, it may function like an absent tie, which can be exploited.

The proportional strength of a tie with respect to all ties of a person is a

simple indicator of the importance or exclusivity of a tie. It is computed as the

value of the line(s) representing a tie, divided by the sum of the values of all lines

incident with a person. If line values express costs, time, or energy, the

proportional strength of a tie is the portion of an actor’s total expenditure which

is ‘invested’ in the ties with an alter. Just like dyadic constraint, it makes a

difference from which standpoint you look at the network, for instance, the tie

between Alejandro and Bob is one out of Alejandro’s four relations (0.25) but it

is only one of Bob’s seven relations (0.14), so the proportional strength of a tie

must be represented by a directed network (Figure 6). Note that the original

network may contain multiple lines, directed and undirected lines, and line

values, but the network with proportional strength relations is always simple

directed and contains only bi-directed arcs.

Figure 6 - Proportional strength of ties around Alejandro.

The dyadic constraint on vertex u exercised by a relation between vertices u and

v is the extent to which u has more and stronger relations with neighbors who are

strongly connected with vertex v.

This definition describes the ideas behind dyadic constraint rather than the exact

computation. For those interested in the exact computation: add the proportional

strength of the relation from ego to alter (investment of ego in alter) to the

products of the proportional strength of the two arcs in each path from ego to

alter via another neighbor of ego and  take the square of this sum.
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The constraint on Alejandro attached to his relation with Eduardo is equal to

the square of the following sum: 0.25 (Alejandro’s investment in Eduardo), plus

0.25*0.33 (Alejandro’s tie to Carlos times Carlos’ tie to Eduardo), plus 0.25*0.33

(idem via Domingo). All numbers are proportional strengths which can be read

from Figure 6. The sum is 0.415 and the square of this sum is 0.17 (see Figure 7).

As you may have expected, the constraint on Alejandro which is attached to his

ties with Domingo or Carlos is also 0.17 and the constraint on his tie with Bob is

just the square of the proportional strength of this tie (0.0625) because there are

no indirect paths from Alejandro to Bob in Alejandro’s ego-network.

We may conclude that the constraint on Alejandro’s tie with Bob is about one

third of the constraint of his ties within the Hispanic cluster. Clearly, the

structural holes in Alejandro’s network are attached to his link with Bob: he is

able to play the tertius gaudens role between Bob and the other Hispanics

because he may act as a representative of the Hispanics towards Bob.

Figure 7 - Constraints on Alejandro.

If we have the dyadic constraint on all relations of a person, we can simply add

them to obtain the aggregate constraint on this person. The aggregate constraint

is a nonnegative number which is usually between 0 and 1 but it can be more than

one. The aggregate constraint on Alejandro, for instance, is 0.174 + 0.174 +0.174

+ 0.063 = 0.585. The higher the aggregate constraint, the less ‘freedom’ a person

has to withdraw from existing relations or to exploit structural holes.

People or organizations with low aggregate constraint are hypothesized to

perform better. It has been shown that employees with low constraint in an

organization have more successful careers and that business sectors with lower

constraint on firms are more profitable. In general, researchers compare the

constraint on an actor to one or more indicators of its (economic) success. In our

example, this could be the success in resolving the conflict between employees

and management or personal influence on the conditions specified in the final

agreement. Bob and Norm negotiated the proposal with the management before

they called in the union representatives, so they may have been successful in

changing the conditions according to their interests.

Application

In Pajek, one command computes the proportional strength of relations, the

dyadic constraint, and the aggregate constraint for all vertices in a network. This

command is aptly called Structural Holes and you can find it in the Net>Vector

submenu. The proportional strength of relations is output as a new network and
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so is dyadic constraint. In these networks, the line values express the strength and

constraint on relations respectively. Note that these networks are always directed

and that all arcs are reciprocated, no matter whether the original network is

directed or undirected, valued or unvalued, whether it contains multiple lines and

loops or not.

There is an easy way to visualize the structural holes in a network. Take the

network of dyadic constraint and energize it using line values as similarities

(option Options>Values of Lines>Similarities in the Draw screen). Now, vertices

which are tied by relations of high constraint are drawn closely together, whereas

relations of low constraint are long, so they create a lot of space between the

vertices which looks like a hole (Figure 8).

Figure 8 - Energized constraint network.

Aggregate constraint is output as a vector. You may inspect this vector in the

usual ways with the Info>Vector command or by editing it. If you want the size of

the vertices to represent their aggregate constraint in the Draw screen, we advise

to multiply the vector by 10 (command Vector>Transform>Multiply by) or use

the Autosize option in the Options>Size>of Vertices submenu of the Draw screen,

otherwise the vertices are drawn too small.

7.5 Affiliations and brokerage roles

Group affiliation is often important in brokerage processes. A union

representative mediates between the management and the workers. He can

negotiate with one manager or another and he can choose whom of his colleagues

to consult. To some extent, his contacts are replaceable by someone else from the

same group. Moreover, the union representative himself must belong to a

particular group, namely the workers. In our example, the union representatives

Sam and Wendle are a subgroup of workers and the management is supposed to

negotiate with them. This restricts the managers’ choice of negotiation partners
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enormously, so they have little opportunity to play off one negotiator or worker

against another. In this case, the opportunity to broker depends not only on the

position of people in the network but also on their group affiliations.

The easier it is to replace your contact by someone else from his or her group,

the stronger your position is to negotiate and the higher the chance of striking a

good deal or of getting things done your way. The replacement does not have to

be one of your present contacts, it may be someone outside of your present ego-

network whom you may consider to include in it at the expense of someone else.

Is there someone else in the group of your contact who is at least as central as

your contact but who is not directly linked to your contact so including him in

your ego-network would create a structural hole between your present contact and

the new contact? Such a structural hole is called a secondary structural hole.

Let us illustrate this with an example. Suppose Alejandro wants to play a

divide and rule strategy against Bob because he feels too constrained by him. Bob

is in a good structural position to negotiate on behalf of the English-speaking

young employees because he is directly connected to most members of this group.

It is very difficult to spread discord among members of his group by spreading

rumors about Bob, because the other members of the group are likely to inform

Bob when they maintain direct relations. Alejandro’s best choice seems to be

Gill, because he is not directly connected to Bob and it is very likely that Frank

will team up with him, after which Gill may try to play Ike versus Hall and John,

although these colleagues are constrained by Bob. Frank and Karl, the only other

English-speaking young employees who are not directly related to Bob, are less

suited as an alternative to Bob because they are less central in the group.

Since secondary structural holes concern the relations within one group,

namely the opportunities to exploit structural holes within that group, the

aggregate constraint within a group seems to be a useful indicator of whom to

contact and persuade as an alternative to your present contact in the group: the

person who is least constrained and who is not constrained by your present

contact because he is not directly tied to him or her (see Figure 11 in the

Application Section).

Figure 9 - Five brokerage roles of actor v.

For another approach to brokerage and affiliations, we have to turn to triads

again. A triad in which person v mediates transactions between persons u and w

can display five different patterns of group affiliations, which are indicated by

vertex color as well as contours in Figure 9. Each pattern is known as a brokerage

role. Research into brokerage roles is concerned with describing the types of

v

u w

coordinator

v

u w
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v
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v
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v
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brokerage roles which dominate a transactional or exchange network. In addition,

individual positions within the network may be characterized by the dominant

type of brokerage role and hypotheses may be tested about the personal

characteristics of individuals with certain types of brokerage roles.

Two brokerage roles involve mediation between members of one group. In

the first role, the mediator is also a member of the group. This is known as the

coordinator role. In the second role, two members of a group use a mediator from

outside, an itinerant broker. The other three brokerage roles describe mediation

between members of different groups. In one role, the mediator acts as a

representative of his group because he regulates the flow of information or goods

from his or her own group. In another role, the mediator is a gatekeeper, who

regulates the flow of information or goods to his or her group. Finally, the liaison

is a person who mediates between members of different groups but who does not

belong to these groups himself or herself.

The five types of brokerage roles have been conceived for directed networks,

namely transaction networks. Note, however, that the direction of relations is

only needed to distinguish between the representative and the gatekeeper. The

other brokerage roles are also apparent in undirected relations, so we can apply

the brokerage roles to undirected networks if we do not distinguish between

representatives and gatekeepers. In an undirected network, each representative is

also a gatekeeper and vice versa.

Now, let us have a look at the brokerage roles in the strike network. We use

the groups according to language and age (see Figure 1) and we assume that a line

is equivalent to a bi-directional arc: discussing work implies the possibility to

spread and receive information. Employees who are isolated or whose relations

are contained within a clique, e.g., Carlos, Domingo, and Eduardo but also

Wendle and Xavier, have no opportunity to mediate because all of their contacts

are directly connected. As a result, none of the brokerage roles apply to them.

Most of the other employees have relations only within their own group, so

they can only play the coordinator role. In the network, brokerage is clearly

dominated by the coordinator role. It is easy to see that Alejandro, Bob, Norm,

and Ozzie are the only employees who also have other types of brokerage roles

because they are the only ones who are connected to members of different groups.

Figure 10 - Bob's ego-network.
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Let us have a closer look at Bob (Figure 10), who combines several types of

brokerage roles. There are several structural holes among Bob’s relations within

the group of English-speaking young employees, e.g., between Ike and Mike on

the one hand, and Hal, John, and Lanny on the other hand. To them, Bob plays

the coordinator role. In addition, Bob bridges many structural holes between his

group of English-speaking young employees and the Hispanic workers or the

older employees. For information about his group, Bob is a representative and for

information flowing towards members of his group, he is a gatekeeper. Finally, he

may mediate between Alejandro and Norm, that is, between the Hispanics and the

older workers. In this role, he is a liaison. The only brokerage role which Bob

cannot play given the relations in the network, is the role of an itinerant broker

because he does not have relations with two or more members of any group other

than his own. Actually, none of the employees can play this role - this role is

absent in the strike network.

Bob was the first employee whom the management contacted directly.

Perhaps, this was justified not only by the amount of structural holes in his ego-

network but also by the variety of brokerage roles which Bob may play.

Application

Secondary structural holes are related to constraint within a group, so we may

delete the relations between groups and calculate the constraint within each

group. If there is another member of the group with equal or less constraint than

the one you are already connected to, you may play him off against your present

contact provided that they are not strongly and directly connected. In a similar

manner, you may evaluate your position within your own group to see whether

you may easily be replaced by someone else.

The detection of secondary structural holes consists of two steps. In the first

step, we delete the lines between groups. Since the groups are defined as classes

in a partition (in our example Strike_groups.clu), we must make sure that

this partition is selected in the partitions drop list. Then we can        remove the

lines between clusters with the command Operations>Transform>Remove

Lines>

Between Clusters.

In the second step, we apply the Structural Holes command to the network

without lines between clusters to obtain the constraint of vertices within their

groups (Figure 11). Now, we can see that Gill is even less constrained within the

class of young English-speaking employees than Bob. Since there is no direct

relation between Gill and Bob, Gill seems to be a good candidate to be played off

against Bob. In the Hispanic group, there is no real alternative to Alejandro

because he is directly connected to all others. Among the older employees, Norm

is clearly less constrained than any other employee, so there is no good

alternative in this group. Judging from their structural positions and ignoring their

linguistic abilities or special relationships, we conclude that Norm and Alejandro

Operations>Transform

>Remove Lines

>Between Clusters

Net>Vector

>Structural Holes
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are less likely to be replaced as representatives or gatekeepers of their groups than

Bob because there is a good alternative to Bob only.

Figure 11 - Constraint inside groups.

Pajek contains a command which counts the brokerage roles in a network. Make

sure that the network and the appropriate partition are selected in the drop lists of

the Main screen. Then, execute the command Operations>Brokerage Roles to

obtain five partitions, one for each brokerage role. The class number of a vertex

in a partition specifies the number of incomplete triads in which this vertex plays

the corresponding brokerage role. A frequency table of a partition is obtained in

the usual way (Info>Partition). Table 1 shows the results for the coordinator role.

Table 1 - Frequency tabulation of coordinator roles in the strike network.

Class Freq Freq% CumFreq CumFreq% Representative

0 10 41.6667 10 41.6667 Frank

1 5 20.8333 15 62.5000 Hal

2 3 12.5000 18 75.0000 Ike

4 2 8.3333 20 83.3333 Utrecht

5 1 4.1667 21 87.5000 Gill

6 1 4.1667 22 91.6667 John

7 1 4.1667 23 95.8333 Bob

9 1 4.1667 24 100.0000 Norm

Sum 24 100

We can see that 10 employees have no coordinator roles. The number of

coordinator roles pro person is unevenly distributed: quite some employees have

one or two coordinator roles whereas Norm has no less than nine coordinator

roles. If you sum the roles (five employees with one coordinator role plus three

with two roles, etc.), we count 46 coordinator roles. In the representative roles

partition we count 21 roles and there is just one liaison role. As noted before, the
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coordinator role occurs most frequently in this network because most employees

have direct relations only within their own subgroup.

7.6 Summary

In a connected social network, information may reach anybody through their ties.

Holes in this network, that is, absent ties, are obstacles to flows of information.

Information is less likely to reach anybody easily in a connected network with

large holes. In this chapter, we focus on the holes in a network. The information

flow is especially vulnerable in networks with bridges and cut-vertices because

the removal of a bridge or cut-vertex disconnects the network. Actors who are

cut-vertices in a network control the flow of information from one part of the

network to another. They may decide to retain information when it suits their

personal purposes.

From the perspective of the communication system as a whole, bridges and

cut-vertices are undesirable. From the individual point of view, however, being a

cut-vertex is attractive because it offers opportunities for brokering information

and for profiting from brokerage in one way or another. The advantage of the

broker position in an ego-network, which is the network of one actor and its

neighbors, is that you can play a tertius strategy: you can induce competition or

conflict between neighbors who are not linked directly. The gap between the

neighbors is called a structural hole and each structural hole represents an

opportunity to broker.

There is drawback, however: you must avoid to be the object of a tertius

strategy yourself. This implies that you cannot end relations to neighbors who are

directly linked. This is called the constraint on your relation with a neighbor. The

constraint on a relation is inversely related to the structural holes associated with

it: low constraint means many structural holes and vice versa. The constraint on

each relation as well as on each vertex in the network may be calculated to find

the segments which have most opportunities to broker, which are hypothesized to

be more successful and profitable.

In many social contexts, brokerage is connected to group affiliations and the

people involved can only be replaced by other persons from their groups.

Threatening a contact to replace him or her by another contact is also a tertius

strategy. This strategy is only successful if there is a good alternative to the

present contact in the group, someone who is also quite central in the group but

who is not directly linked to the present contact so the (secondary) structural hole

between them can be exploited.

When we consider brokerage in the context of group membership, there are

five brokerage roles. We can characterize a network or an actor in a network by

the kinds of brokerage roles which occur. The brokerage signature of a network

or actor can be compared to other characteristics to determine whether certain

types of actors or types of social relations develop particular brokerage roles.
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7.7 Exercises

1 List the bridges in the network depicted below.

2 How many bi-components and cut-vertices does the network of exercise 1

contain?

a Three bi-components and three cut-vertices.

b Three bi-components and six cut-vertices.

c Six bi-components and three cut-vertices.

d Six bi-components and six cut-vertices.

3 Let the network of Exercise 1 represent the communication network within

an organization. If you would like to reduce the power of cut-vertices to

control the flow of information, which pair of vertices would you urge to

establish a communication relation? Justify your answer.

4 Which of the following statements is correct?

a Vertices incident with a bridge are cut-vertices if and only if they have

two or more neighbors.

b Vertices which are part of a bi-component cannot be cut-vertices.

c A bi-component is a subnetwork without cut-vertex.

d If there are two paths between all pairs of vertices in a component, this

component is a bi-component.

5 Use the definitions of a bridge, a cut-vertex, and a bi-component to explain

that two vertices connected by a bridge are a bi-component of size two and

that each bi-component of size two contains a bridge in a simple undirected

network.

6 Which of the following statements about the strength of weak ties hypothesis

is correct?

a Strong family ties cannot be bridges in a communication network.

b A tie is weak if and only if it is a bridge in a communication network.
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c In general, weak ties are more likely to be bridges in a communication

network.

d A tie is strong if and only if it is part of a clique in a communication

network.

7 In the network of Exercise 8, which  vertex is least constrained: v4, v7, or

v13? Justify your answer.

8 In the network below, vertex color indicates the group to which a vertex is

affiliated. When vertex v7 wants to reduce the number of relations which he

is maintaining, which relation would you advise him to end?

9 Count each brokerage role which vertex v7 may play in the network of

Exercise 8.

7.8 Assignment

In our discussion of the triad, we compared complete and nearly complete triads.

We stressed the opportunities which the incomplete structure offers to the person

in the middle and the constraint exercised by the complete triad. Especially in the

case of public behavior, that is, behavior which cannot be concealed from people

in other groups, it has been argued that membership in several different cliques is

very stressful because it obliges a person to conform to the - supposedly different

- sets of norms of the different cliques. In this position, a person has very little

room to maneuver.

In particular instances, this hypothesis contradicts the structural holes

argument. If a person is a member in several different cliques, there are structural

holes between the cliques, which may be exploited. In the network depicted in

Figure 12, for example, vertex v3 may exploit structural holes between the other

members in the 3-clique (v1 and v2) and the other members in the 4-clique (v4,

v5, and v6). According to the structural holes hypothesis, vertex v3 is least

constrained. According to the hypothesis of overlapping cliques, however, v3 is

most constrained because it is a member in two cliques.
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Figure 12 - Two overlapping cliques.

Having two competing hypotheses, it is interesting to see which one applies in a

particular situation. Our case is a small hi-tech computer firm which sells,

installs, and maintains computer systems. The data file hi-tech.net contains

the friendship relations among the employees, which were gathered by means of

the question: Who do you consider to be a personal friend? Three employees

(Fran, Quincy, and York) did not return the questionnaire. Note that most

friendship nominations are reciprocated, but not all (112 out of 147).

Some months later, employees tried to unionize the firm: they sought support

among the employees to let the union have a say in the firm. The three top

managers (class three in the partition hi-tech.union.clu) and three

employees who were not directly involved (class two) were opposed to union

certification of the firm. Five employees (class one) were pro-union, but two of

them (Chris and Ovid) did not actively advocate the pro-union position. At the

end, the proposal to unionize the firm was voted down. Chris resigned from the

firm ten days before the vote because he did not want to participate in it. He

rejoined the firm two days after the vote.

Analyze these data, which are joined in the project file Hi-tech.paj, and

argue whether they support the structural holes argument or the overlapping

cliques hypothesis. For the analysis of cliques, review Section 3.6 in Chapter 3.

Pay attention to the position and behavior of Chris in particular. In addition,

analyze the brokerage roles if the groups are defined by their stance towards

unionization (hi-tech.union.clu) and find out whether this explains Chris’

behavior.

7.9 Further Reading

•  The example is taken from J.H. Michael, ‘Labor dispute reconciliation in a

forest products manufacturing facility’ (Forest Products Journal, 47 (1997),

41-45).

•  G. Simmel explains his ideas about triadic configurations in the chapter

‘Individual and society’ of his book The Sociology of Georg Simmel (New

York, London: The Free Press, 1950, a translation of Soziologie.

Untersuchungen über die Formen der Vergesellschaftung, Berlin: Duncker &

Humblot, 1908). A recent approach from a different angle can be found in

H.C. White, Identity and control. A structural theory of social action

(Princeton, New Jersey: Princeton University Press, 1992).
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•  Mark Granovetter’s Getting a job: a study of contacts and careers (Chicago:

The University of Chicago Press, 1974) is the source of the strength of weak

ties hypothesis. The second edition (1995) includes an appendix which

surveys and analyses research based on this hypothesis.

•  The theory of structural holes was introduced by R.S. Burt in his book

Structural holes. The social structure of competition (Cambridge/London:

Harvard University Press, 1992), which contains applications of this theory to

careers of managers and to the profitability of business sectors.

•  The five types of brokerage roles were proposed by R.V. Gould & R.M.

Fernandez in ‘Structures of mediation: a formal approach to brokerage in

transaction networks’ (Sociological Methodology 1990,San Francisco:

Jossey-Bass, 1989, 89-126).

•  The example used in the assignment as well as the theory of constraint by

overlapping cliques stems from D. Krackhardt’s ‘The ties that torture:

Simmelian tie analysis in organizations’ (Research in the Sociology of

Organizations, 16 (1999), 183-210).

7.10 Answers

1 The lines between v13 and v2, v14, and v15 are bridges. If you remove one

of these lines, v2, v14, or v15 becomes an isolate, so the network contains

two components instead of one.

2 Answer c is correct. The network contains three cut-vertices: v4, v7, and v13.

Removal of any of these vertices disconnects the network. Cut-vertex v4

belongs to two bi-components: one bi-component contains vertices v1, v3,

v4, v12, and v16 and the other bi-components consists of v4, v7, and v13. In

addition, cut-vertex v7 belongs to the bi-component v5, v6, v7, v8, v9, v10,

v11. Cut-vertex v13 belongs to three bi-components in addition to the ones

already mentioned, because the three pairs of vertices connected by bridges

(see Exercise 1) are bi-components.

3 In order to reduce the control of a cut-vertex, you must join two or more bi-

components into one bi-component. A tie between members of the two

largest bi-components, which are not cut-vertices, produces this effect, for

instance, between vertices v3 and v6. Now, v4 and v7 are not cut-vertices

anymore.

4 Statement a is correct. A vertex which is incident to a bridge can only have

less than two neighbors if its only neighbor lies at the other side of the

bridge. The vertex, then, is a ‘hanger’ like v2 in the network of Exercise 1. If

you remove this vertex, you do not create a new component. If the vertex has

two or more neighbors, however, it mediates between the vertex at the other

side of the bridge and its other neighbor(s). When you remove the vertex, the

latter neighbor is disconnected from the network, so the number of

components in the network increases.

Statement b is not correct because a vertex in a bi-component may well be a
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cut-vertex in the network at large, e.g., vertices v4, v7, and v13 in the

network of Exercise 1. Statement c is not correct because a subnetwork is not

necessarily connected. It may consist of several components which are not

one bi-component by definition. Finally, statement d is not correct because

the two paths between a pair of vertices may share a vertex in between the

end-points, for instance, the paths v16-v3-v4-v7 and v16-v1-v4-v13-v7 in the

network of Exercise 1. This vertex (v4) is a cut-vertex, so the component is

not a bi-component.

5 It is easy to see that a pair of vertices connected by a bridge make up a bi-

component of size two, since a bridge has two vertices (hence, size two),

neither of which is a cut-vertex because if you remove one vertex, the

remaining vertex still constitutes one component. Removing a vertex does

not increase the number of components, so it is a bi-component by definition.

Note that we look at the isolated bridge now, not at the entire network which

may contain this bridge.

Does every bi-component of size two include a bridge in a simple undirected

network? A bi-component of size two contains two vertices which are

connected by lines because a bi-component is a component: a maximal

connected subnetwork. It is important to note, that the two vertices are not

connected indirectly, via one or more other vertices, because those vertices

would also be part of the bi-component: they would constitute a cycle in an

undirected network, which does not contain a cut-vertex since there are two

paths connecting each pair of vertices. Hence, the two vertices are connected

only by direct ties. If the network is simple, it does not contain multiple lines,

so the two vertices are connected by one line, which is a bridge by definition

because its removal disconnects the two vertices, which splits the original

component in two, so the number of components increases.

6 Answer c is correct. It is not ruled out that a strong family tie is a bridge in an

information network, for instance the tie between Frank and Gill in the strike

network, so answer a is not correct. Strong and weak ties are defined on the

basis of their frequency or intensity, not on their structural features, so it is

not ruled out that strong ties occur outside cliques and weak ties occur inside

cliques, so answers b and d are incorrect. However, there is a statistical

association between the property (strength) of a tie and its structural location,

so we may say that weak ties are more likely to be bridges in general, which

is answer c.

7 Vertex v13 is less constrained than vertices v4 and v7. Note, first, that these

three vertices have the same degree: each has five neighbors. As a

consequence, the proportional strength of their relations is equal, namely

0.20. Therefore, we do not have to bother with the proportional strength of

relations and we can simply count the number of structural holes around each

vertex to find out who is least constrained. We count only one direct tie

among the five neighbors of vertex v13, namely between v4 and v7, so nine

out of the ten possible pairs of neighbors are not directly linked: they are
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separated by structural holes. Among the neighbors of v7, two pairs are

directly linked, which leaves eight structural holes. Finally, three pairs of

v4’s neighbors are directly linked, so there are seven structural holes. More

structural holes means less constraint, so vertex v13 is least constrained.

8 It is not wise to withdraw from relations which are part of a complete triad

because that allows a neighbor to play the tertius strategy against you. Vertex

v7 has only one tie outside a complete triad, namely the relation with vertex

v10. He may safely withdraw from this relation because he is already

connected to vertex v9, which is the most central member of the green group.

9 Vertex v7 does not broker between members of its own group, so he cannot

play the coordinator role. V7 is connected to three vertices in the ‘green’

group, two of whom are directly connected, so he is an itinerant broker

between v10 on the one hand and v6 and v9 on the other hand. V7 may

mediate between v4, who is a member of his group, and three vertices in the

‘green’ group: v6, v9, and v10. Here, v7 plays the representative or

gatekeeper role, which occurs three times. Finally, v7 may mediate between

three green neighbors and one yellow neighbor, which yields six liaisons.

Vertex v7 is a liaison predominantly.
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